Instaliranje i podesavanje
AutoCAD-a

U ovom dodatku govorimo o nacinu instaliranja AutoCAD-a 2005 i o sistemskim para-
metrima koje bi trebalo definisati da biste AutoCAD podesili tako da vam odgovara.
Sistemske promenljive koje su u vezi s nekim parametrom (kada su dostupne) date su
na kraju opisa opcije, u zagradama. To su parametri pomocu kojih kontrolisete kako ce
se AutoCAD ponasati pri kori§éenju raznih komandi i osobina. Sistemske promenljive
su detaljno opisane u dodatku C.

Pre instaliranja AutoCAD-a

Pre nego $to pocnete instaliranje, morate imati barem 300 MB slobodnog prostora na
disku na kojem ¢ete instalirati AutoCAD. Potrebno je jo§ i 100 MB slobodnog prostora za
AutoCAD-ove privremene datoteke i datoteke za razmenu podataka (engl. swap files),
zatim jo§ 20 MB za datoteke koje ¢ete praviti tokom obuke. Ukoliko instalirate AutoCAD
na disk na kome nije instaliran Windows, proverite da li imate barem 220 MB slobodnog
prostora na disku na kome je Windows. AutoCAD tamo ¢uva privremene datoteke.

Takode treba da imate Windows 2000 ili XP (verziju Home ili Professional), Internet
Explorer 6 sa servisnim paketom 1, racunar sa procesorom Pentium III na 800 MHz ili
brzim, najmanje 256 MB RAM-a i graficku karticu koja podrzava rezoluciju 1024 x 768 u
punom koloru.

Imajte pri ruci ime i telefonski broj prodavca jer se ti podaci upisuju tokom instali-
ranja. Sistemi za jednog korisnika mogu se besplatno koristiti 30 dana, §to znaci da
moZete instalirati i koristiti AutoCAD i pre nego $to unesete autorizacioni kod. Autoriza-
cioni kodd moZete da dobijete faksom, telefonom ili posredstvom Interneta, §to je nazna-
¢eno kada prvi put pokrenete AutoCAD.
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Postupak instalacije

AutoCAD 2005 se instalira kao i svaki drugi program za Windows, ali bi neke stvari trebalo
da znate pre nego $to pocnete. Ovaj odeljak sadrzi podatke koji ¢e vam pomoci kada
zapocCnete sa instalacijom.

Instaliranje AutoCAD-a

Instaliranje AutoCAD-a je jednostavno i jasno; AutoCAD koristi carobnjake za instala-
ciju kao i ve¢ina drugih Windowsovih programa. Nave§c¢u smernice koje treba da pratite
tokom procesa instalacije.

u

Pre nego $to zapocnete instalaciju, proverite da li imate dovoljno praznog pro-
stora na disku i utvrdite da nisu pokrenuti drugi programi. Trebalo bi da imate
serijski broj i CD kljuc pri ruci (obi¢no su oznaceni na pakovanju).

Obi¢no se instalacioni program AutoCAD-a pokrece automatski ¢im ubacite CD

AutoCAD 2005 u CD uredaj na racunaru. Ako se ne pokrene, ucinite sledece:

1. UWindowsu odaberite Start > Run da biste otvorili okvir za dijalog Run.

2. U polje Open upisite D:setup. Umesto slova D iz primera unesite slovhu
oznaku CD jedinice. Kada to zavrsSite, pritisnite OK. Prikazuje se okvir za dija-
log AutoCAD 2005 Master Setup.

Pri vrhu okvira za dijalog Master Setup nalaze se opcije: Install, What's Inside,

Documentation, Support i Network Deployment. Pritisnite Install. U okviru za

dijalog bice prikazane opcije za instaliranje. Pritisnite Install u okviru opcije
Install AutoCAD 2005.

Posto je instalacija pocela, pratite instrukcije ¢arobnjaka za instalaciju. U okviru
za dijalog Personal Information upisacete svoje ime, kompaniju za koju radite
iime i telefon prodavca od koga ste kupili AutoCAD. Ti podaci se prikazuju na
uvodnom ekranu AutoCAD-a, pa pazite $ta Cete otkucati da se ne biste kasnije
kajali.

Takode se trazi da izaberete lokaciju za AutoCAD-ove datoteke. U veZbama u ovoj
knjizi pretpostavlja se da se AutoCAD nalazi na disku C u direktorijumu \Program
Files\AutoCAD2005\ - talokacija je predloZena tokom instalacije.

Moci éete da birate izmedu Cetiri vrste instalacija: Typical, Full, Compact i Custom.
Savetujem da izaberete instalaciju tipa Full kako biste mogli da iskoristite sve
mogucnosti AutoCAD-a.

Ako nemate dovoljno prostora na disku, u prozoru ¢arobnjaka videcete tacno
koliko prostora treba da imate na svakom disku koji koristite tokom instalacije
AutoCAD-a. Upotrebom usluznih programa Windows Explorer i Windows Disk Cle-
anup moZete napraviti viSe prostora na disku. Kada obezbedite potreban prostor i
pre nego §to se vratite u AutoCAD Setup, proverite da li ste zatvorili ove programe.
Kada instalirate AutoCAD, vraticete se u okvir za dijalog Master Setup. Instalirajte
i AutoCAD Express Tools u okviru opcije Install Supplemental Tools.

Po zavr$etku instalacije AutoCAD-a 2005, pojavice se okvir za dijalog u kome se traZi
da ponovo pokrenete (restartujete) racunar, pa to i ucinite.
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Instaliranje ostalih komponenata AutoCAD-a

Ako niste na pocetku instalirali neke komponente AutoCAD-a, kao $to su alatke za rad
s bazama podataka a hocete da ih instalirate naknadno, sledite navedene korake:

1. Stavite CD sa AutoCAD-om 2005 u CD uredaj na racunaru.

2. Ukoliko se okvir za dijalog AutoCAD 2005 Master Setup ne pojavi automatski,
odaberite Start > Run da biste otvorili okvir za dijalog Run.

3. U polje Open unesite D:setup, gde je slovom D oznacen CD uredaj.

4. Odaberite opciju Install iz niza opcija na vrhu, a potom pritisnite Install u okviru
opcije Install AutoCAD 2005. Program za instalaciju otkrice da imate vec¢ instali-
ran AutoCAD na racunaru, tako da c¢ete moci da birate izmedu slede¢ih moguc-
nosti: da dodate ili deinstalirate neku od mogucnosti AutoCAD-a, da reinstalirate
ili popravite AutoCAD 2005 ili da uklonite AutoCAD 2005 s racunara. Izaberite
opciju Add Or Remove Features i zatim pritisnite Next. Pojavice se okvir za dijalog
s listom opcija AutoCAD-a koje moZete instalirati.

5. Sliste izaberite opciju koju hocete da instalirate. Pojavice se padajuci meni sa
skupom opcija za instalaciju. Odaberite odgovarajucu opciju.

6. Ponovite peti korak za svaku opciju koju Zelite da ukljucite u instalaciju AutoCAD-a.
Kada zavrsite, pritisnite Next.

7. Na pitanje hocete li da nastavite instalaciju, pritisnite Yes da biste instalirali iza-
brane opcije.

AutoCAD-ove programske datoteke

U direktorijumu \Program Files\AutoCAD2005, nalazi se niz poddirektorijuma.
Evo kratkog opisa sadrzaja svakog poddirektorijuma:

Backup SadrZirezervne verzije mnogih AutoCAD-ovih sistemskih datoteka.

Data Links Ovo jelokacija datoteke Data Link za opciju dbConnect iz verzija Auto-
CAD-a starijih od verzije 2004. U AutoCAD-u 2005 je sacuvana zbog kompatibilnosti
sa starijim verzijama. Datoteke Data Link sada se smeStaju u direktorijum C: \Docu-
ments and Settings\korisnic¢ko ime\Application Data\Autodesk\
AutoCAD 2005\R16.1\enu\Data Link.

Drv SadrZi posebne pokretacke programe koje AutoCAD koristi za Stampanje na
ploteru i funkcije prikaza.

En-US SadrZiizvorne datoteke za americku verziju AutoCAD-a. Verzije prilagodene
korisnicima iz drugih zemalja imaju drugacija imena direktorijuma.

Express SadrZi datoteke s podrSskom za alatke Express. Ovaj direktorijum cete videti
samo ako ste prethodno instalirali alatke Express.

Fonts Sadrzi fontove AutoCAD-a.
Help Sadrzi AutoCAD-ovu dokumentaciju za pomo¢.

Plot Styles Ovo je lokacija stilova Stampanja na ploteru za verzije AutoCAD-a
starije od verzije 2004. U AutoCAD-u 2005 je satuvana zbog kompatibilnosti. Stilovi
Stampanja na ploteru sada se smeSstaju u direktorijum C: \Documents and Set-
tings\korisni¢ko ime\Application Data\Autodesk\AutoCAD 2005\R16.1\
enu\Plot Styles.
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Plotters Ovo jelokacija konfiguracionih datoteka plotera za verzije AutoCAD-a
starije od verzije 2004. U AutoCAD-u 2005 je sacuvana zbog kompatibilnosti. Konfigu-
racione datoteke plotera sada se smes$taju u direktorijum C: \Documents and Set-
tings\korisnic¢ko ime\Application Data\Autodesk\AutoCAD 2005\
R16.1\enu\Plotters.

Sample Sadrzi primere crteza i ActiveX, DesignCenter, VBA i VisualLISP datoteke.

Support SadrZi datoteke s definicijama raznih AutoCAD-ovih funkcija koje se mogu
prilagodavati.

Template Ovo jelokacija Ssablona za verzije AutoCAD-a starije od verzije 2004. U
AutoCAD-u 2005 je satuvana zbog kompatibilnosti. Sabloni se sada smestaju u direk-
torijum C: \Documents and Settings\korisni¢ko ime\Application Data\
Autodesk\AutoCAD 2005\R16.1\enu\Template.To je takode ilokacija za §ablone
skupova listova.

Textures Ovo je lokacija datoteke sa teksturama za AutoCAD-ovo sencenje povr-
§ina za verzije AutoCAD-a starije od verzije 2004. U AutoCAD-u 2005 je sacuvana
zbog kompatibilnosti. Datoteke sa teksturama sada se smeStaju u direktorijum
C:\Documents and Settings\korisnic¢ko ime\Application Data\Autodesk\
AutoCAD 2005\R16.1\enu\Textures.

Tutorial SadrZi Autodeskove datoteke za ucenje.
UserDataCache SadrZiizvorne datoteke za korisnicke podatke.
WebDepot SadrZi datoteke tipa HTML za registraciju dok ste povezani na Internet.

WebServices Sadrzi datoteke za AutoCAD-ove Web servise, kao §to je Communica-
tion Center.

Ukoliko prilagodavate program, radite s datotekama iz direktorijumaC: \Documents
and Settings\korisni¢ko ime\Application Data\Autodesk\AutoCAD 2005\
R16.1\enu. Tu cete pronaci poddirektorijume Data Links, Plot Styles, Plotters i Support
koji rade s vasim korisnickim imenom u Windowsu. Ako postavite datoteke sa prilago-
denim pode$avanjima u ovaj direktorijum, vise korisnika mogu na istom racunaru da
imaju sopstvenu prilagodenu konfiguraciju.

Podesavanje AutoCAD-a

U ovom odeljku nauciéete kako da podesite rad AutoCAD-a. AutoCAD moZete da pode-
site i tokom rada s programom, preko okvira za dijalog Options.

VeZbe u ovoj knjizi su pripremljene s pretpostavkom da upotrebljavate unapred
podesene parametre Options. Kada bolje upoznate AutoCAD, moZete da podesite nje-
gove parametre preko okvira za dijalog Options. Mnoge opcije iz tog okvira mogu
se podesiti i preko sistemskih promenljivih.

Odaberite Tools > Options da biste otvorili okvir za dijalog Options koji sadrZi sle-
dece kartice i parametre.

SAVET  Mnoge opcije u okviru za dijalog Options prikazuju ikonicu AutoCAD-ove datoteke.
Ta ikonica govori da ce parametri opcije biti sacuvani s datotekom, a ne kao deo AutoCAD-
ovih podrazumevanih parametara.
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Kartica Files

Pomocu opcija s kartice Files zadajete gde ¢e AutoCAD cuvati ili traziti datoteke koje su
mu neophodne za rad. Tu su hijerarhijske liste slicne onima iz Windows Explorera. Prvo
Cete videti opSte teme izlistane u poljima Search Path, File Names and File Locations.
Prikaz svake teme moZete prosiriti ako pritisnete znak plus s leve strane.

Sledi opis svih stavki iz liste. Verovatno vecinu njih necete koristiti, dok cete druge
menjati po potrebi.

[& Dptions 21|

Current profile: <<Unnamed Prafiles » Current diawing Drawing].dwg

Displayl Open and Savel F'Iull\ngl Systeml User F’refelencesl Draflingl Selectiunl F’mfilesl

Browse: |

Add..

FBemaove |

Search paths, file names, and file locations:

% Support File Search Path 155
E Working Suppatt File Search Path

% Device Driver File Search Path

Project Files Search Path

ﬁ tdenu, Help, and Miscellaneous File Mames

Gl - )

ﬁ Text Editar, Dictionary, and Font File Mames
E PFrint File, Spooler, and Prolog Section Mames
a PFrinter Support File Path
% Automatic 5ave File Location

ffove Up |
Teve Down |
Set Current |

% Color Book Locations
% Data Sources Location
ﬁ Dirawing Template Settings
% Tool Palettes File Locations
% Log File Location
-, Temporary Drawing Flle Location LI

1B} B BB B

Specify the Folders in which AutaCAD should lock for test fants, menus, plug-ins, drawings to
insert, linetypes, and hatch patterns that are not in the curent folder

o]

Cancel | Apply | Help |

SAVET  Sistemska promenljiva data je u uglastim zagradama, na kraju opisa svake stavke.
SUPPORT FILE SEARCH PATH
U mnogim svojim funkcijama, AutoCAD se oslanja na pomoc¢ne datoteke. Meniji, fontovi
za tekst, vrste linija, asocijativne Srafure, samo su neke od opcija koje sadrze pomocéne
datoteke. Opcija Support File Search Path saopstava AutoCAD-u gde da traZi takve dato-
teke. Putanje za datoteke moZete dodati u liste tako Sto Cete pritisnuti taster Add i uneti
novu putanju ili ¢ete to uraditi pomocu dugmeta za pretraZivanje, Browse. Postojece
stavke nemojte brisati ako niste sigurni da je ta odluka ispravna.

Ako umete da koristite promenljive za okruZenja, mozete i njih da ukljucite u putanje
pretraZivanja.

WORKING SUPPORT FILE SEARCH PATH
Sadrzi listu putanja na kojima AutoCAD traZi pomocne datoteke specifi¢ne za opera-
tivni sistem.
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DEVICE DRIVER FILE SEARCH PATH

DefiniSe polozaj upravljackih programa AutoCAD-a. Upravljacki programi (engl. device
drivers) su aplikacije koje omogucavaju AutoCAD-u da komunicira sa stampacima, plo-
terima i ulaznim uredajima. U vecini slucajeva, te parametre ne treba da menjate.

PROJECT FILES SEARCH PATH

Postoji mogucnost da od konsultanta ili od drugog korisnika AutoCAD-a dobijete dato-
teke koje sadrze reference na druge crteZe i rasterske slike. Obi¢no takve datoteke zahte-
vaju tacno odredeni direktorijum za Xref crteZe i rasterske slike. Ako ih premestite na
drugo mesto s razli¢itim sistemom direktorijuma, one nece moci da pronadu svoje refe-
rencirane crteZe. Opcija Project Files Search Path omogucava da zadate direktorijum za
Xref datoteke ili slicne zavisne datoteke. Ukoliko AutoCAD ne moZe da pronade Xref
datoteku ili neku drugu datoteku, potrazice je u direktorijumu koji ste zadali.

Da biste zadali taj direktorijum, odaberite opciju Project Files Search Path i pritisnite
dugme Add. AutoCAD ¢e predloziti da ime direktorijuma bude Projectl. To ime moZete
promeniti. Pritisnite znak plus pored polja u kome je upisano Projectl i izaberite Browse
da biste definisali putanju. Putanja se ¢uva u sistemskoj promenljivoj Projectname [Pro-
jectname].

MENU, HELP, AND MISCELLANEOUS FILE NAMES

Ova stavka omogucava da definiSete razliCite datoteke podrske, kao §to su datoteke za
menije, pomo¢, automatsko snimanje, izlazak na mrezu i konfigurisanje. MozZete defini-
sati i Internet adrese kojima pristupate preko dugmeta Launch Browser sa standardne
palete alatki AutoCAD-a. Ukoliko imate mreZnu instalaciju, definiSite i lokaciju za
License Manager.

TEXT EDITOR, DICTIONARY, AND FONT FILE NAMES

Ovu stavku koristite za definisanje editora teksta [mtexted], korisnickih i standardnih
reCnika [Dctmain, Dctust] i razli¢itih fontova i mapa fontova [Fontalt]. U poglavlju 8
naci cete vise detalja o ovome.

PRINT FILE, SPOOLER, AND PROLOG SECTION NAMES

Kada koristite opciju Plot to File, datotekama moZete dati imena drugacija od standard-
nih koje dodeljuje AutoCAD. Opcija Spooler definiSe aplikaciju koja treba da procita i
Stampa tako napravljenu datoteku. Opcija Prolog se odnosi na izvoz PostScript datoteka.
Ona omogucava da definiSete odeljak Prolog u datoteciAcad . psf koji AutoCAD treba da
izveze zajedno s datotekama u formatu Encapsulated PostScript. U dodatku B i poglavlju
14 bilo je viSe reci o izvozu PostScript datoteka i o datoteci Acad.psf [Psprolog].

PRINTER SUPPORT FILE PATH

Postoji nekoliko datoteka podrske povezanih sa AutoCAD-ovim sistemom za Stampanje
na ploteru i Stampacu. Ova stavka omogucava da zadate gde ¢e AutoCAD traZiti te dato-
teke.

AUTOMATIC SAVE FILE LOCATION
Ovom stavkom zadajete poloZaj AutoCAD-ove datoteke Automatic Save [Savefilepath].
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COLOR BOOK LOCATION

Ova stavka omogucava da zadate lokacije za katalog boja PANTONE. Ovaj katalog
moZete naknadno da instalirate s kompakt diska AutoCAD-a 2005 ako ga niste instalirali
S programorm.

DATA SOURCES LOCATION
Omogucava da definiSete polozaj ODBC Data Link datoteka koje se koriste za povezi-
vanje AutoCAD-ovih crteza s datotekama baze podataka.

TEMPLATE SETTINGS

Kada izaberete opciju Use a Template iz okvira za dijalog Create New Drawing, AutoCAD
iz ovog parametra traZi lokaciju datoteke sa Sablonima. Podrazumevani parametar
mozete da izmenite, ali to verovatno nece biti potrebno.

TooL PALETTES FILE LOCATION

Omogucava da zadate lokaciju za izvorne datoteke paleta alatki koje ste sami napravili.
Kada pravite palete, AutoCAD ce podatke o tim paletama smestiti na zadatu lokaciju.

LOG FILE LOCATION
Pomocu ove opcije zadajete mesto na koje ce biti smestene datoteke evidencija [Logfile-
path].

PLOT AND PUBLISH LOG FILE LOCATION
Pomocu ove opcije zadajete mesto na koje ce biti smestene datoteke evidencija Plot i
Publish [Logfilepath].

TEMPORARY DRAWING FILE LOCATION

AutoCAD pravi priviemene datoteke da bi cuvao delove crteza dok radite na njemu.
Obicno ne treba da brinete o privremenim datotekama, sem ako ne po¢nu da se gomi-
laju na disku ili ako radite s vrlo velikom datotekom na sistemu s malo memorije.
Pomocu ove opcije moZete da odredite mesto za privremene datoteke. Standardna loka-
cija je direktorijum C: \Documents and Settings\korisni€ko ime\Local Set-
tings\ Temp.Korisnicko ime je ono pod kojim se prijavljujete na sistem. Ukoliko
imate brz disk s dosta slobodnog prostora, iskoristite ovu opciju da biste na njega sme-
stili priviemene datoteke i tako poboljsali performanse [Tempprefix, read-only].

TEMPORARY EXTERNAL REFERENCE FILE LOCATION

Da bi neki drugi korisnik iz mreZe mogao da otvori Xref datoteku ili datoteku na kojoj
radite, s padajuce liste Demand Load Xrefs na kartici Open And Save moZete izabrati
Enabled with Copy. AutoCAD ce praviti i koristiti kopije bilo koje ucitane Xref datoteke
tako da originalnu datoteku mogu otvoriti i drugi. Stavka Temporary External Reference
File Location omogucava definisanje direktorijuma u kome AutoCAD c¢uva kopiju Xref
datoteke [Xloadpath].

TEXTURE MAPS SEARCH PATH

Omogucava da zadate lokaciju za AutoCAD-ove mape tekstura koje se koriste u realistic-
nim prikazima. U vecini slu¢ajeva, te parametre necete morati da menjate. Ipak, moZete
dodati direktorijum za mape tekstura koje ste dobili ili napravili.
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Pomocu ove opcije zadacete lokaciju za datoteke koje uvozite na racunar koristeci
AutoCAD-ovu funkciju i-drop. Nijedna lokacija nije podrazumevano navedena, pa se
.DWG datoteke uvezene pomocu i-dropa smestaju u isti direktorijum u kojem se nalazi
aktuelni crtez.

NAPOMENA

Dok je AutoCAD otvoren, lako cete saznati lokaciju izvora, kao $to je datoteka
evidencije ili datoteka automatskog snimanja. Iskoristite funkciju AutoLISP Getvar uz ime
sistemske promenljive povezane sa izvorom. Na primer, da biste brzo pronasli lokaciju
datoteke evidencije, unesite (getvar "logfilepath")0. Za automatsko zapisivanje datoteke une-
site (getvar "savefilepath")l] Korisnici LT-a mogu da iskoriste komandu Modemacro, na
primer, ModemacroO $(getvar,logfilepath)U ili Modemacroll $(getvar,savefilepath)Cl. Vise
podataka o komandi Modemacro pronaci cete u poglavlju 20.

Kartica Display

Parametri sa ove kartice omogucavaju da kontrolisete izgled AutoCAD-ovog prozora.
Pomocu ovih parametara moZete zadati da AutoCAD-ov prozor izgleda potpuno dru-
gacije. MoZete da promenite trake za pomeranje sadrZaja, fontove i boje.

I# Options

Current profile: <<Unnamed Profile:»

Files

pen and Savel P\oltingl System' Usger Pleleremcesl Drafting' Selection' Proli\es'

2l
Current drawing: Drawing].dwg

[ Window Elements
¥ Displap sorall bars in drawing window
I™ Display soreen menu

LColorz.. Eonts. ..

i~ Digplay resolution

IW Arc and circle smoothness
IS— Segments in a polyline curve
05 Rendered object smoothhness
4 Cortour lines per surface

~ Lapout elements
¥ Display Layout and Model tabs
¥ Displap margine
[V Display paper background

¥ Display paper shadow
¥ Shaw Page Setup dislog for new layouts
[V Create viewport in new layouts

r~ Display performance:
[ Pan and zoom with raster image
[¥ Highlight raster image frame only
¥ True color raster images and rendering
v pply solid fill
[~ Show test boundary frame only
[~ Show sihouettes in wireframe

r~ Crozshair size

F_ -l

 Reference Edit fading intensity —————————————————

|50 J'

Ok I Cancel Apply Help

GRUPA WINDOW ELEMENTS
Ove opcije kontroliSu opste parametre AutoCAD-ovog prozora:

Display scroll bars in drawing window Ukljucuje i iskljuCuje trake za pomeranje
sadrzaja. Ako imate mali monitor s niskom rezolucijom, iskljucite ih da biste povecali
prostor za crtanje.

Display screen menu Ukljucuje stari meni AutoCAD Format Screen koji se ranije
nalazio na desnom kraju ekrana. Ako vam je zaista potreban, ovde cete ga ukljuciti.
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Colors Otvara okvir za dijalog u kojem moZete da zadajete boje raznim komponen-
tama AutoCAD-ovog prozora. Ako vam crna ne odgovara, ovde moZete da promenite
boju povrsine za crtanje.

Fonts Otvara okvir za dijalog u kojem birate fontove za AutoCAD-ov prozor. MoZete
da birate iz standardne grupe Windowsovih fontova dostupnih na vasem sistemu.

GRUPA DISPLAY RESOLUTION
Ove opcije kontrolisu nacin na koji su objekti u AutoCAD-u prikazani. Sami odlucujete
hocete li dati prednost preciznom prikazivanju ili brzini.

Arc and circle smoothness KontroliSe izgled lukova i krugova, pogotovo kada ih
uvecate. U nekim slu¢ajevima, lukovi i krugovi izgledaju kao mnogouglovi (iako ce
na ploteru biti iscrtani kao lukovi i krugovi). Ukoliko hocete da lukovi i krugovi budu
zaobljeniji, povecajte vrednost ovog parametra. Time ce se povecavati i koli¢ina
memorije koja se koristi. Ove parametre kontroliSe i sistemska promenljiva Viewres
[Viewres].

Segments in a polyline curve Kontrolide zaobljavanje sloZenih linija. Sto je vrednost
veca, linije e izgledati zaobljenije. Ako smanjite broj, iscrtavanje ¢e biti brze. Ove
parametre kontroliSe i sistemska promenljiva Splinesegs [Splinesegs].

Rendered object smoothness KontroliSe izgled zakrivljenih punih tela kada ih reali-
sti¢no prikazujete i sencite. Vrednost promenljive moZze da se krec¢e od 0.01 do 10
[Facetres].

Contour lines per surface Omogucava da definiSete broj linija konture kojima se
predstavljaju pune zakrivljene povrsine. Vrednost se krec¢e od 0 do 2047 [Isolines].

GRUPA LAYOUT ELEMENTS

Ove opcije reguliSu nacin prikazivanja elemenata crteZa u reZimu Paper Space Layout.
U poglavljima 7 i 13 nalazi se detaljnije objasnjenje. Funkcionisanje vecine ovih opcija je
ocigledno. Opcija Show Page Setup Manager For New Layouts otvara okvir za dijalog pri
prvom otvaranju elemenata. Opcija Create Viewport In New Layouts automatski pravi
prikaz u postavci elemenata kada se ona prvi put otvori.

GRUPA DISPLAY PERFORMANCE
Opcije ove grupe omogucavaju da podesite parametre i prikaz.

Pan and zoom with raster & OLE KontroliSe nacin na koji rasterske slike reaguju
na pomeranje i zumiranje. Ako je ova opcija izabrana, rasterske slike se pomeraju
s kursorom. Iskljucite ovu opciju radi boljeg uc¢inka [Rtdisplay].

Highlight raster image frame only Odreduje kako e rasterska slika izgledati kada
je izabrana. Ukljucite je radi §to boljeg u¢inka [Imagehlt].

Apply solid fill KontroliSe izgled popunjenih objekata kao $to su debele sloZene
linije i povr$ine popunjene punom Srafurom. Ovu opciju kontroli$e i sistemska pro-
menljiva Fillmode. Vi§e o popunjenim sloZenim linijama i punim $rafurama naci
¢ete u poglavlju 13. Iskljucite ovu opciju radi boljeg ucinka [Fillmode].
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Show text boundary frame only KontroliSe nacin prikazivanja teksta. Ukljucite ovu
opciju da biste tekst zamenili pravougaonicima cije dimenzije priblizno odgovaraju
veli¢ini prvobitnog teksta [Qtextmode].

Show silhouettes in wireframe Kontrolise da li e biti prikazane povrSinske mreze
modela punih tela. Iskljucite ovu opciju radi boljeg ucinka [Dispsilh].

KLizAC CROSSHAIR SIZE

Klizacem se reguliSe veli¢ina kursora koncanice. Ovu vrednost mozete podesiti na 100
procenata da biste dobili kursor konc¢anicu preko celog ekrana, kao u starijim verzijama
AutoCAD-a [Cursorsize].

KLizAC REFERENCE EDIT FADING INTENSITY
Klizac kontrolise izgled objekata koji nisu izabrani tokom dorade referenci. U poglavlju
6 naci cete viSe detalja o menjanju referenci [Xfadectl].

Kartica Open And Save
Na kartici Open And Save nalaze se opste opcije za rad s datotekama, kao §to su auto-
matsko snimanje i standardni format datoteke crteZza za komande Save i Save As.

[#: options d |
Curret profile: <<Unnamed Profile:> Current drawing: Drawingl.dwg
Files | Display I Plotting I Sypstem | User Preferences I Drrafting | Selection | Profiles |
File Save r~File Dpen
Save as ] Mumnber of recently-used files to list
J&utoCAD 2004 Drawing [*.dwg] =l
¥ Displap full path in titke
[¥ Save a thumbnail preview image
ISD Incremental save percentage " Entemal References (refs]
Demand load #refs:
Dizabled -
r File Satety Precautions I J
[ laomatckere g Rietain changes to ref layers
[E8 ™ Allow other users to Refedit current drawin
0 Minutes between saves = e
7 Elea.te backup copy with each save ~ ObjectaR, Applications
™ Fulltime CRC walidation Demand laad ObjectsRX apps
I Maintain a log file - -
I Object detect and command invoke ﬂ

ac$ File extension for temporary files
Proxy images for custom objects:

ISth prosy araphics d

Security Options..
I Show Prozy Information dialog bos

¥ Displap digital signature information

ak. I Cancel Apply Help

GRUPA FILE SAVE
Koriste¢i opcije iz ove grupe mozete da zadate kako ¢e AutoCAD ¢uvati datoteke.

Save as Padajuca lista omogucava da definiSete standardni format datoteke za
opcije File > Save i File > Save As. Na primer, ako radite u okruZenju u kojem morate
da koristite datoteke AutoCAD-a 14 kao standardne, pomocu ove opcije izaberite
Release 14 kao standardni tip datoteke. AutoCAD takode moZete podesiti da dato-
teke standardno ¢uva u DXF formatu.
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Thumbnail preview settings Omogucava da zadate da li ¢e uz crtez biti sacuvan i
njegov umanjen prikaz. Ove umanjene slike koriste se u okviru za dijalog AutoCAD
File i DesignCenteru da biste videli datoteku pre nego $to je otvorite [Rasterpreview].
Takode moZete da kontroliSete i prikaz skupa listova [Updatethumbnail].

Incremental save percentage KontroliSe delimi¢no zapisivanje datoteka svaki put
kada izaberete opcije File > Save ili File > Save As. Delimi¢no zapisivanje datoteka
skracuje vreme snimanja datoteke na disk ali takode povecava datoteku. Ako nemate
mnogo prostora na disku, vrednost ove opcije podesite na 25. Vrednost 0 potpuno
iskljucuje funkciju delimi¢nog snimanja, ali pogor§ava AutoCAD-ove performanse.
Ova opcija se kontroliSe i preko sistemske promenljive Isavepercent [Isavepercent].

GRUPA FILE SAFETY PRECAUTIONS
Ove opcije zadaju osobine automatskog snimanja rezervnih datoteka u AutoCAD-u.

Automatic save Omogucava da kontroliSete funkciju Automatic Save. MoZete da je
iskljucite, ukljucite ili da podesite ucestalost snimanja datoteke uno$enjem vrednosti
u polje Minutes between saves. Putanju na kojoj se zapisuju datoteke moZete da
podesite koristeci stavku Automatic Save File Location na kartici Files, okvira za dija-
log Options. Ucestalost automatskog snimanja podesavate i preko sistemske pro-
menljive Savetime [Savefilepath, Savefile].

Create backup copy with each save Omogucava da odredite da li ¢e datoteka .BAK
biti snimljena svaki put kada snimite datoteku. Ako Zelite da sacuvate prostor na
disku, bilo bi dobro da iskljucite ovu opciju. MozZete je ukljuciti i iskljuciti preko
sistemske promenljive Isavebak [Isavebak, Tempprefix].

Full-time CRC validation Proverava celovitost svakog objekta nastalog u AutoCAD-
u. (CRC su pocetna slova od Cyclic Redundancy Check - ciklicna dodatna provera).
MozZe da se koristi kao pomoc¢ pri reSavanju problema, da se ukljuci kada se sumnja
na problem s hardverom ili AutoCAD-om.

Maintain a log file Omogucava da zabeleZite podatke u AutoCAD-ovom prozoru za
tekst. Ova osobina je detaljnije opisana u poglavlju 14. Mesto za smeStanje datoteka
za evidenciju mozete da odredite na kartici Files okvira za dijalog Options [Logfile-
mode, Logfilename].

File extension for temporary files Omogucava da zadate oznaku tipa AutoCAD-
-ovih privremenih datoteka. Te datoteke AutoCAD koristi za privremeno ¢uvanje
podataka iz crteZa, za slucaj da ostane bez memorije. Ukoliko ste na mreZi, privre-
mene datoteke raznih korisnika mogu da budu smestene u istom direktorijumu.
Da biste znali koje su datoteke vase, promenite ovaj parametar.

Security Options Otvara istoimeni okvir za dijalog u kom datoteku moZete zastititi
lozinkom ili joj dodati digitalni potpis. U poglavlju 22 detaljnije se govori o ovim
funkcijama.

Display digital signature information Prilikom otvaranja datoteke sa digitalnim

potpisom, ova opcija ¢e vas upozoriti na prisustvo digitalnog potpisa [Sigwarn]. U
poglavlju 21 nadi ¢ete vise podataka o digitalnim potpisima.
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GRUPA FILE OPEN
Pomocu ovih opcija kontroliSete nacin na koji AutoCAD prikazuje imena datoteka u
meniju File ili na naslovnoj traci crteza.

Number of recently-used files to list U ovom polju za unos moZete zadati broj dato-
teka koje ce biti prikazane u listi nedavno kori$¢enih datoteka u meniju File. Una-
pred podeSena vrednost je 4, a moZete uneti vrednosti izmedu 01 9.

Display full path in title Pomocu ove opcije kontrolisete da li je i putanja uklju¢ena
u ime crteza prikazano na naslovnoj traci.

GRUPA EXTERNAL REFERENCES (XREFS)
Ove opcije omogucavaju da kontroliSete osobine memorije i slojeva Xref datoteka.

Demand load Xrefs Omogucava da ukljucite funkciju Demand load Xrefs. Ta funk-
cija poboljsava performanse datoteka koje koriste Xref datoteke ucitavajuci samo
one delove Xref crteza koji su neophodni u tekuéem otvorenom crtezu. Ova opcija
sadrzi tri podopcije: Disabled, iskljucuje funkciju Demand Load; Enabled ukljucuje
funkciju a Enabled with Copy ukljucuje funkciju Demand Load Xref koristeci kopiju
izvorne Xref datoteke. Poslednja opcija omogucava da i ostali koji rade na mreZzi
doraduju izvornu Xref datoteku dok vi radite na datoteci koja takode koristi tu Xref
datoteku [Xloadctl].

Retain changes to Xref layers Omogucava da snimite parametre sloja Xref datoteka
na tekucem crteZu, a da to ne utice na izvornu Xref datoteku. Kada je ovaj parametar
isklju€en, tekuca datoteka uvozi parametre sloja Xref datoteke prilikom ucitavanja te
datoteke. Ovaj parametar mozete da definiSete i sistemskom promenljivom Visretain
[Visretain].

Allow other users to Refedit current drawings Pomocu ove opcije odredujete da li
ostali mogu istovremeno da doraduju datoteku koju vi doradujete. Ova opcija omo-
gucava da i drugi koriste opciju Modify > In-Place Xref and Block Editing (komanda
Refedit) pri radu s datotekama koje ste ucitali u AutoCAD [Xedit].

GRUPA OBJECT ARX APPLICATIONS

AutoCAD omogucava da korisnici ili nezavisni proizvodaci aplikacija prave objekte za
¢iju je podrsku najcesce potrebna posebna ObjectARX aplikacija. Ove opcije kontrolisu
nacin na koji AutoCAD tretira takve objekte i ObjectARX aplikacije koje su s njima u vezi.

Demand load ObjectARX apps Kontrolise kada ce aplikacija nezavisnog proizvodaca
biti u¢itana ako u datoteci postoji objekat kome je potrebna. Ova opcija nudi nekoliko
parametara dostupnih s padajuce liste. Parametri su: Disable Load on Demand,
Custom Object Detect, Command Invoke i Object Detect and Command Invoke. Prvi
parametar sprecava AutoCAD da ucita aplikacije drugih proizvodaca ako postoji obje-
kat kome su neophodne. Obratite paznju na to da neke standardne AutoCAD-ove
komande nece raditi ako izaberete opciju Disable Load on Demand zato §to AutoCAD
koristi ObjestARX aplikacije. Drugi parametar ¢ini da AutoCAD automatski u¢ita ARX
aplikaciju. Tre¢i parametar ucitava aplikaciju kada pozovete neku komandu te aplika-
cije. Cetvrti parametar ucitava ARX aplikaciju ako postoji objekat kome je potrebna ili
kada pozovete neku komandu te aplikacije [Demandload].
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Proxy images for custom objects Nudi padajucu listu na kojoj se nalaze tri parame-
tra koja kontrolisu prikaz objekata kada u sistemu ne postoje ARX aplikacije koje ih
podrzavaju. Parametar Do Not Show Proxy Graphics iskljucuje prikazivanje takvih
objekata. Parametar Show Proxy Graphics prikazuje takav objekat. Parametar Show
Proxy Bounding Box umesto prilagodenog objekta prikazuje granice tog objekta.

Show Proxy Information dialog box Omogucava da izaberete da li ¢e se pojavljivati
upozoravajuci okvir za dijalog Show Proxy Information. Ako je ova opcija izabrana,
upozorenje Show Proxy Information se pojavljuje kada otvorite crteZ s prilagodenim
objektima, a AutoCAD ne moZe da pronade objekte povezane sa ARX aplikacijom
[Proxynotice].

Kartica Plot And Publish

Kartica Plot And Publish okvira za dijalog Options nudi parametre za podeSavanje Stam-
panja na ploteru i Stampacu. Opis ovih opcija pronaci cete u poglavlju 7 i u dodatku B.

Kartica System
Opcije s kartice System kontroliSu neke parametre glavnog AutoCAD-ovog interfejsa,
kao 8to su upravljacki programi za prikazivanje i pokazivacki uredaji.

I% Options gl
Current profile: <<Unnamed Profile: Current drawing: Drrawingl.dwa

User F‘lelerencesl Draftmgl Selechnnl F‘rnh\esl

Files | Dlsp\ayl Open and Savel Plotting

 Current 3D Graphics Digplay —————————— [~ General Dptions

IGSHEIDH 0 vl Properties... | I™ Single-drawing compatibility mode

¥ Display OLE properties dialog

¥ Showal waring messages

i~ Current Pointing Device

B t
IEunEnt Spstem Pointing Device j [~ Beep on enor in user input .
™ Load acad.lsp with every drawing

Acceptinput from: ¥ Allow long symbol names

| Digitizer only

= Startup: Do not show a startup dialo b
% Digitizer and mouse I P 4 J
r Lapout Regen Options: i~ Live Enabler Optiohs
® B tin srtim i I~ Check Wb for Live Ensblers

" Cache model tab and last layout i
0 B e el e |5 b aximum number of unsuccessful checks

- dbCannect Optians
¥ Store Links index in drawing file
™ Open tables in read-only mads

ak. I Cancel Apply Help
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GRUPA CURRENT 3D GRAPHICS DISPLAY

Ova grupa sadrZi padajucu listu i dugme Properties. Padajuca lista nudi sve dostupne
sisteme za prikazivanje 3D grafike. Standardna opcija, GSHEIDI10, Autodeskov je sistem
za prikazivanje 3D grafike Heidi 3D Graphics. Ostale stavke moZete da kupite od nezavi-
snih proizvodaca.

Dugme Properties otvara okvir za dijalog 3D Graphics System Configuration s dodat-
nim opcijama pomocu kojih moZzete kontrolisati alatke 3D Orbit i Shade Mode. Opcije
ovog okvira za dijalog razlikovace se u zavisnosti od toga koja je stavka izabrana na
padajucoj listi. Ako koristite standardni sistem za prikazivanje, GSHEIDI10, pogledajte
odeljak Podesavanje AutoCAD-ovog sistema za 3D grafiku, u ovom dodatku.

GRUPA CURRENT POINTING DEVICE
Preko opcija ove grupe moZete da izaberete vrstu pokazivackog uredaja koji ¢ete kori-
stiti u AutoCAD-u. Padajuca lista nudi opcije Current System Pointing Device i Wintab
Compatible Digitizer. Ako hocete da koristite standardni Windowsov pokazivacki uredaj,
izaberite opciju Current System Pointing Device. Ukoliko upotrebljavate tablu za digita-
lizaciju koja koristi upravljacki program Wintab, izaberite opciju Wintab Compatible
Digitizer.

Ako éete u AutoCAD-u koristiti samo table za digitalizaciju, morate to dodatno potvr-
diti izborom radio-dugmeta Digitizer only. Ukoliko izaberete radio-dugme Digitizer and
mouse, AutoCAD ce prihvatati oba uredaja.

GRUPA LAYOUT REGEN OPTIONS
Ovim skupom radio-dugmadi odredujete kako se regeneriSe crtez prikazan na karti-
cama Layout.

Regen when switching layouts Zadajete AutoCAD-u da regeneriSe crtez kada izabe-
rete karticu Layout ili Model. Koristite ovu opciju ako nemate dovoljno radne memo-
rije u racunaru.

Cache model tab and last layout Birate opciju koja ne regenerise crtez kada prela-
zite iz rezima Model u rezim Layout u kome ste poslednji put radili. Ako izaberete
neku drugu karticu rezima Layout, crtez ¢e biti regenerisan.

Cache model tab and all layouts Birate opciju koja ne regeneriSe crtez, u kom god
rezimu radili.

GRUPA DBCONNECT OPTIONS
Ova polja za potvrdu omogucavaju da kontroliSete funkciju dbConnect.

Store Links index in drawing file Omogucava da izaberete gde ce biti sacuvani
podaci za vezu s bazom podataka. Ako je ova opcija potvrdena, podaci veze se Cuvaju
u crtezu koji je povezan s bazom podataka. Ovim se povecava datoteka i produzava
njeno ucitavanje.

Open tables in read-only mode Omogucava da ogranicite pristup datotekama baze
podataka.
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GRUPA GENERAL OPTIONS
Ovaj skup polja za potvrdu omogucava da definiSete opcije u vezi sa op$tim operaci-
jama AutoCAD-a.

Single-drawing compatibility mode Omogucava da kontroliSete da li ée vam Auto-
CAD dozvoliti da otvorite viSe dokumenata ili ¢e vas ogranic¢iti na samo jedan, kao u
prethodnim verzijama AutoCAD-a [Sdi].

Display OLE properties dialog Omogucava da kontroliSete prikazivanje okvira za
dijalog OLE Properties. Taj okvir za dijalog se pojavljuje kada u AutoCAD-ov crtez
umetnete OLE objekte. Ovu funkciju moZete da iskljucite tako Sto cete u okviru za
dijalog OLE Properties ukloniti znak za potvrdu iz polja Display OLE Properties Dia-
log When Pasting New OLE Objects. Kad koristite ovu opciju, moZete i da ukljucite
isti okvir za dijalog.

Beep on error in user input Ukljucuje zvucni signal svaki put kada program detek-
tuje gresku u ulaznim podacima.

Show all warning messages Ako pomocu opcije Don’'t Display This Warning Again
iskljucite poruku upozorenja, ova opcija omogucava da ponovo aktivirate sve poruke
upozorenja. Ukoliko nijedna poruka upozorenja nije iskljucena, ova opcija je neak-
tivna.

Load Acad.lsp with every drawing Odreduje dali ¢e datoteka Acad. 1sp biti ucitana
sa svakim crtezom. Ako ste navikli da datoteku Acad . 1sp koristite sa AutoCAD-om,
izaberite ovu opciju; u suprotnom, AutoCAD ¢e ucitati samo datoteku Acaddoc. 1sp
[Acadlspasdoc].

Allow long symbol names Omogucava da stavkama kao $to su slojevi, blokovi,
tipovi linija i imena stilova teksta date duga imena. Kada je ova opcija ukljucena,
moZete da unesete ime koje se sastoji od najvise 255 znakova [Extnames].

Startup U ovoj padajucoj listi moZete da definiSete da li ¢e AutoCAD pri prvom
pokretanju prikazati okvir za dijalog AutoCAD Startup i da li ¢e se, kada odaberete
File > New, otvarati okvir za dijalog Create New Drawing. Ako je odabrana opcija
Show Startup Dialog Box, ovi okviri za dijalog ¢e se pojavljivati. Ukoliko nije, Auto-
CAD ¢e automatski otvarati podrazumevani prazan dokument na osnovu poslednje
datoteke Sablona koja je koriSc¢ena, a kada odaberete File > New, pojavljivace se okvir
za dijalog Select Template.

GRUPA LIVE ENABLER OPTIONS
Od verzije AutoCAD 14, nezavisni proizvodaci imaju mogucénost da stvaraju objekte
poznate kao proxy objects koristeci alatku za programiranje ObjectARX. Kada je ta
novina uvedena, morali ste da imate instaliranu aplikaciju nezavisnog proizvodaca ako
ste hteli da pregledate ili menjate objekte nastale koriséenjem takve aplikacije. Pod poj-
mom object enablers podrazumevamo male programe, AutoCAD-ove dodatke, pomocu
kojih moZete pregledati ili menjati objekte nastale pomocu aplikacija nezavisnih proiz-
vodaca iako niste celu aplikaciju nezavisnog proizvodaca instalirali na racunar.

Ovakvi programi se nalaze na Webu i, ako je to dozvolio proizvodac, mozZete ih
besplatno preuzeti. AutoCAD ¢e ih potraziti na Internetu ako izaberete opciju Check
Web for Live Enabler. Na primer, ako ste primili datoteku napravljenu u Architectural
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Desktopu koja sadrZi takav objekat, AutoCAD se automatski povezuje sa Autodeskovom
Web stranicom i preuzima Architectural Desktop Object Enabler, tako da moZete men-
jati i pregledati datoteku. Opcije Live Enabler omogucavaju da kontroliSete kako se pro-
grami tipa Object Enabler koriste ako AutoCAD naide na objekte nastale pomocu
aplikacija nezavisnih proizvodaca.

Maximum number of unsuccessful checks Pomocu ove opcije definisete koliko ¢e
puta AutoCAD pokusati da se poveZe s Internetom ako je prvi pokusaj povezivanja
bio neuspesan.

Kartica User Preferences

Opcije kartice User Preferences omogucéavaju da podesite na koji nacin ¢e AutoCAD rea-
govati na unose.

[fa options 20|
Curmert profile: <<Unnamed Profile>> Curent drawing: Diawingl.dwg

Files | Display| Dpen and Save | Plot and Publish | System {1681 Pifeféntes] Drafling | Selection| Profles |

~wiindows Standard Behavir—————— - Friority for Cooreinate Data Enty
¥ Windows standard acceleraior keys  Running object snap
W Shortcut menus in diawing area " Keyboard entry
Riight-click Customization @ Keyboard entry except scripts
- Diag-and-diop scal r Dimensianing
Diefault settings when urits are set to unifless:
¥ Make new dimensions associative
Saurce content units:
Inches -
i~ Hyperlink
Target d i
AEESICEEES [ Displap hyperlink curser, toaltip, and shorteut menu
Inches -
Hidden Line Settings. Fie
I¥ Display backgiound of felds
Lineweight Seltings.
Field Update Settings.

ok | Cancel Ll Help

GRUPA WINDOWS STANDARD BEHAVIOR
Ovi parametri omogucavaju da odredite kako ¢e se AutoCAD ponasati kada pritisnete
tastersku kombinaciju ili desni taster misa.

Windows standard accelerator keys Ako ukljucite ovu opciju, u AutoCAD-u pri-
menjujete standardnu Windowsovu kombinaciju tastera: Ctrl+C (kopiraj na Clip-
board) i Ctrl+V (prenesi s Clipboarda). Kada ova opcija nije potvrdena, AutoCAD
kombinaciju Ctrl+C razume kao komandu Cancel, a Ctrl+V kao komandu Viewport
Toggle.

Shortcut menus in drawing area Kada pritisnete desni taster misa, a ukljucena je
ova opcija, pojavice se priru¢ni meni. Ako nije potvrdena, AutoCAD pritisak na desni
taster mis$a tretira kao pritiskanje tastera Enter [Shortcutmenul].

Right-click Customization Otvara istoimeni okvir za dijalog, koji nudi jo$ opcija za
podesavanje funkcija desnog tastera misa u AutoCAD-u.
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ick Customization x|

Quick click for ENTER
Longer click to display Shortcut Menu

Longer click duration: [250 milliseconds

Default Mods
If no objects are selected, right-click means
" Repeat Last Command
{+ Shartcut Menu

~ Edit Mode
If one or more objects are selected, right-click means
" Repeat Last Command
{* Shortcut Menu

[~ Command Mode
If a command is in progress, nght-click means

" ENTER
= Shortout Menu always enabled

@ Shortout Menu: enabled when command options are presant

Apply & Cloze I Cancel Help

SAVET  Opcija, Turn on time-sensitive right-click odreduje kako ée AutoCAD reagovati kada
korisnik brzo pritisne desni taster misa, ili ga na trenutak drZi pritisnutog. Ukoliko je ova
opcija potvrdena, kratak pritisak na desni taster misa bice isto Sto i pritisak na taster Enter. Ako
taster duze drZite pritisnut, pojavice se prirucni meni. MoZete podesiti i potrebno trajanje
pritiska na desni taster misa.

GRUPA DRAG-AND-DROP SCALE

Pomocu ovih parametara kontroliSete na koji nacin DesignCenter ili funkcija i-drop
odreduju razmeru blokova kada im se dodele merne jedinice za DesignCenter. Svaka
padajuca lista nudi standardni skup jedinica dostupnih u padajucoj listi Insert Units
okvira za dijalog Block Definition. O blokovima sam govorio u poglavlju 6, a u poglavlju
21 o opciji DesignCenter [Insunits].

PRIORITY FOR COORDINATE DATA ENTRY
Pomocu ovih opcija kontroliSete na koji na¢in AutoCAD odgovara na unos koordinata.

Running object snap Zadaje da AutoCAD sve vreme koristi aktivne Osnape [Osnap-
coord].

Keyboard entry Omogucava da koristite tastaturu za unos koordinata.

Keyboard entry except scripts Omogucava da koordinate unesete preko tastature,
osim u makroima [Osnapcoord].

GRUPA ASSOCIATIVE DIMENSIONING

U ovom delu imate jednu opciju, Make New Dimensions Associative, koju moZete ili
iskljuciti ili ukljuciti. Njom definiSete da li ¢e AutoCAD koristiti moguénosti asocija-
tivnog kotiranja koja je uvedena u verziji 2002. Asocijativno kotiranje omogucava da
kote prate promene objekta. Kada koristite staru metodu, morate ukljuciti i tacku
definisanja dok menjate objekat ako hocete da kote prate promene objekta.
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GRUPA HYPERLINK
Ove opcije uklju¢uju i iskljucuju prikazivanje ikonice Hyperlink i njenog priru¢nog
menija.

DUGME HIDDEN LINE SETTINGS

SAVET  Pritisnite dugme Hidden Line Settings da biste otvorili istoimeni okvir za dijalog u
kom moZete kontrolisati izgled 3D prikaza sa skrivenim linijama. Opcijama iz tog okvira za
dijalog kontrolisete izgled skrivenih linija u prikazu koji dobijate komandom Hide ili
u prikazu Hidden Shared. Skrivene linije su podrazumevano nevidljive, ali ih mozete prikazati
u drugoj boji ili drugim tipom linije.

Okvir za dijalog Hidden Line Settings omogucava i da kontrolisete da li ¢e 3D ravni
koje se seku biti oznacene linijom. U ranijim verzijama AutoCAD-a, ravni koje se prese-
caju nisu bile oznac¢avane, ali od ove verzije moZete ih obeleZiti linijjom u prikazima sa
skrivenim linijama. MoZete zadati i boju linije.

DUGME LINEWEIGHT SETTINGS
Pritisnite dugme Lineweight Settings da biste otvorili istoimeni okvir za dijalog. Detalj-
nija objasnjenja ovog okvira za dijalog naci ¢ete u poglavljima 71 13.

GRUPA FIELDS

Ove opcije sadrZe kontrole za prikazivanje i azuriranje polja. Opcijom Display Back-
ground Of Fields podeSavate prikaz sive pozadine polja. Pozadina vam pomaZe da na prvi
pogled uocite koji tekstualni objekt na crtezu predstavlja polje. Pozadina se ne Stampa.
Dugme Field Update Settings otvara okvir za dijalog u kome moZete da izaberete akciju za
azuriranje polja.

Kartica Drafting

Kartica Drafting nudi parametre koji se odnose na kursor za crtanje, ukljucujucii opcije

AutoSnap i AutoTrack.
Current profile: <¢Unnamed Profile:> Current drawing Drawingl . dwg

Fies | Display | Open and Save | Plet and Publish| System| User Preferences |Dafinge Selection | Profies|

~AutoSnap Settings ——————| [ AutaTrack Settings
¥ Marker ¥ Display polar tracking vector
¥ Magret [V Display full-screen tracking vector
| Display AutoSnap taolip [ Display AutaTrack tooltip

™ Display AutoShap aperture box

[~ Alignment Paint Acguisition
AutoSnap marker solor . q

-
ID “relow vI + Automatic
 Shift to acguire
~futoSnap MarkerSize ————— [~ Apertue Size

|
L

(=]

°
I_(_l

~Object Snap Options
¥ Ignore hatch objects

[ ok | coma Apply Help
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GRUPA AUTOSNAP SETTINGS
Opcijama iz ove grupe kontroliSete osobine AutoSnap koje su aktivne kada koristite
markere Osnap.
Marker Ukljucuje mali kvadrat koji se pojavljuje na mestu Osnapa. Ako necete da
koristite ovaj marker, ponistite potvrdu opcije Marker [Autosnap].

Magnet Cini da kursor Osnap ,skace“ na mesto Osnapa prilikom priblizavanja kur-
sora tom mestu [Autosnap].

Display AutoSnap tooltip KontroliSe da li ¢e biti prikazan savet za koris¢enje alatke
Osnap [Autosnap].

Display AutoSnap aperture box Prikazuje kvadrat preko kursora svaki put kada su

markeri Osnap aktivni. Ako ste koristili ranije verzije AutoCAD-a, videcete da je sim-
bol za Aperture Box onaj koji je u ranijim verzijama, pre pojavljivanja osobine Auto-

Snap, koris¢en za Osnape [Apbox].

AutoSnap marker color Omogucava da zadate boju markera AutoSnap.

KLizAC AUTOSNAP MARKER SIZE
Pomerite kliza¢ da biste zadali veli¢inu markera AutoSnap.

GRUPA AUTOTRACK SETTINGS
Pomocu ovih opcija kontroliSete vektor Tracking koji se koristi za Polar Tracking i Osnap
Tracking.
Display polar tracking vector Ukljucuje i iskljucuje vektor Polar Tracking
[Trackpath].
Display full-screen tracking vector Omogucava da odredite da li ¢e se vektor Trac-
king pojaviti preko celog prozora za crtanje, dali ¢e se zaustaviti na poloZaju kursora
ili u preseku dva vektora Tracking [Trackpath].
Display AutoTrack tooltip Ukljucuje ili iskljucuje kratak opis alatke Osnap Tracking
[Autosnap].

GRUPA ALIGNMENT POINT ACQUISITION
Omogucavaju da zadate na koji nacin cete dobiti tacke ravnanja Osnap Tracking.

KLizAC APERTURE SIZE
Pomerite kliza¢ da biste definisali veli¢inu okvira za izbor Osnap [Aperture].

GRUPA OBJECT SNAP OPTIONS

U ovoj grupi nalazi se opcija Ignore Hatch Objects. Kada je ukljucena, ova opcija igno-
riSe objekte tipa Hatch. U protivhom, prianjanje objekata bice uskladeno sa geometri-
jom 3rafure.
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Kartica Selection

Pomocu opcija sa ove kartice okvira za dijalog Options, zadajete nacine na koje cete
birati objekte u AutoCAD-u. MoZete podesiti i osobinu Grips.

I%: Options e 3
Current profile: <¢Unnamed Profile:» Current drawing: Drrawingl.dwg

Files: | Disp\ay' Open and Savel P\oltingl System' Usger Pleleremcesl Drafting

~ Pickbox Size ~ Grip Size
o —J— [ ] —J—
 Selection Modes  Grips
W Moundverb selection Unselected arip color
™ Use Shitt to add to selection II Color 1680 -
I Press and thag Selected grip calar:
¥ Implied windowing
k . I. Red -
[ Object grouping
™ Associative Hatch Hawver grip color
ID Green -

¥ Enatble arips
™ Enable grips within blocks
¥ Enable grip tips

100 Object selection limit for displap of grips

Ok I Cancel Applp Help

KLizAC PIckBOX SIZE
Omogucava da podesite veli¢inu okvira za izbor objekata [Pickbox].

KLizAC GRIP SIZE
Omogucava da podesite veli¢inu ¢vorova [Gripsize].

GRUPA SELECTION MODES
Opcije Selection Modes omogucavaju da kontroliSete stepen AutoCAD-ove prilagode-

nosti za rad u standardnom grafickom korisnickom okruZenju (engl. graphical user
interface, GUI).

Noun/verb selection Pomocu ove opcije AutoCAD radi poput vecine Windowsovih
programa, dozvoljavajuci da objekte izaberete pre nego §to odaberete akciju ili
zadate komandu [Pickfirst].

Use Shift to add to selection Ako potvrdite ovu opciju, moci cete da izaberete vise
objekata primenom standardne metode karakteristicne za GUIL: objekte birate drzeci
taster Shift. Ukoliko ne drZite taster Shift pritisnut, moZete izabrati samo jedan obje-
kat ili grupu objekata koja je obuhvacena prozorom. Kad ne drZite pritisnut taster
Shift dok birate objekte, ponistava se izbor prethodno izabranih objekata. Da biste
ovu opciju ukljucili pomocu sistemske promenljive, parametar Pickadd postavite na
0 [Pickadd].
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Press and drag Ako ovu opciju potvrdite, prozore moZete da rasporedujete stan-
dardnom metodom karakteristicnom za GUI: pritisnite i drZite taster mia na prvom
uglu prozora; zatim, drzedi i dalje taster misa, povucite prozor na pravo mesto. Kada
je suprotan ugao na svom mestu, pustite taster misa. Ovaj parametar se primenjuje
na module Verb/Noun i Noun/Verb. Ako radite sa sistemskom promenljivom, posta-
vite Pickdrag na 1 [Pickdrag].

Implied windowing Kada je ova opcija potvrdena, a nijedan objekat nije izabran, na
zahtev za unos Select objects prozor tipaWindow ili prozor tipa Crossing se auto-
matski aktivira. Ovaj parametar ne utic¢e na parametar Noun/Verb. Za rad sa sistem-

skom promenljivom, postavite Pickauto na 1 [Pickauto].

Object grouping Omogucava da izaberete grupe kao pojedinacne objekte
[Pickstyle].

Associative Hatch Omogucava da odjednom izaberete i Srafuru i njenu granicu
[Pickstyle].

GRUPA GRIPS
Pomocu ovih opcija kontroliSete ¢vorove.

Unselected grip color Omogucava da izaberete boju ¢vorova koji se vide, a nisu iza-
brani [Gripcolor].

Selected grip color Omogucava da odaberete boju izabranih ¢vorova [Griphot].

Hover grip color Omogucava da zadate boju ¢vora kada se kursor nalazi iznad njega
[Griphover].

Enable grips Ukljucuje osobinu Grips.

Enable grips within blocks Ako ukljucite ovu opciju, ¢vorovi u okviru blokova ée se
prikazati. Iako ¢vorove unutar blokova ne moZete da menjate, mozete da ih koristite
kao tacke za biranje [Gripblock].

Enable grip tips Ukljucuje prikazivanje opisa ¢vorova na proizvoljnim objektima
koji ih imaju [Griptips].

Object selection limit for display of grips KontroliSe prikazivanje ¢vorova u zavi-
snosti od broja izabranih objekata. Ako je vrednost 1, ¢vorovi se nece videti kada je
izabrano viSe od jednog objekta. MoZete zadati vrednosti od 1 do 32767. Podrazume-
vana vrednost je 100 [Gripobjlimit].

Kartica Profiles

Ako koristite Windows XP Professional ili Windows 2000, znate da je profil korisnika
sacuvan za svako korisnicko ime. U zavisnosti od toga koje ime koristite za prijavlji-
vanje, imacete razli¢ito podesen Windows. Kartica Profiles nudi sli¢cne funkcije za kori-
snike AutoCAD-a. U profilu moZete da ¢uvate razlicite parametre iz okvira za dijalog
Options i ponovo ih pozivate. MoZete ih sacuvati i kao datoteku s nastavkom .argizatim
takvu datoteku preneti u drugi sistem. Ovo je kao da parametre Options nosite gde god
daidete.
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% options 2l
Current profile: <<Unnamed Profiles > Current drawing: Drrawingl.dwa

5

<<lnnamed Profiles> Set Cument
Add to List..
Rename.
Delete
Export..
Import
Reset

Files | D|sp\ay| Open and Savel P\oltlngl System' User F‘leleremcesl Draftlng' Selection ; Pr

Available profiles:

ak. I Cancel | Apply | Help |

Glavni deo kartice Profiles daje spisak dostupnih profila. <<Unnamed Profile>> je
standardni profil. Ukoliko dodate nove profile, oni ¢e se pojaviti u spisku.

Da biste definisali nov profil, istaknite ime profila na spisku i pritisnite Add to List.
Pojavice se okvir za dijalog Add Profile u koji unosite ime i opis profila. Opis ce se poja-
viti u polju ispod spiska na kartici Profiles kad god izaberete taj profil.

Posto ste definisali nov profil, promenite parametre na ostalim karticama okvira za
dijalog Options. Novi parametri e biti povezani s novim profilom. U profilima se ¢uva
nacin na koji su podeSeni meniji, tako da se mogu upotrebiti kao pomoc¢ pri sredivanju
Sema ili softvera drugih proizvodaca koji su vama prilagodeni. Evo kratkog opisa opcija
sa kartice Profiles:

Set Current Instalira parametre iz izabranog profila.
Add to List Pravi nov profil od postojeceg.

Rename Menjaime i opis profila.

Delete Uklanja odabrane profile iz spiska.

Export Snima profil u datoteku.

Import Ucitava profil koji je snimljen kao datoteka.

Reset Vrednostiizabranog profila vrac¢a na standardne.
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Podesavanje menija s komandama za rad

s tablom

Da biste tablu za digitalizaciju koristili u AutoCAD-u, konfiguriSite masku s menijima.
Otvorite datoteku Tablet.dwg iz direktorijuma Support, koji se nalazi u direktorijumu
AutoCAD 2005 i odStampajte Sablon za masku s menijima koji po veli¢ini odgovara

vasoj tabli za digitalizaciju. Nakon toga ucinite sledece:

1. Dobro pric¢vrstite masku za tablu. Proverite da li maska potpuno pokriva povrsinu

za crtanje na tabli za digitalizaciju.

2. Odaberite Tools > Tablet > Configure. Pojavice se sledeci zahtev za unos:

Enter number of tablet
menus desired (0-4) <0>:

Unesite 40. U sledecem nizu zahteva odredicete mesto za Cetiri oblasti za menije

na tabli za crtanje pocevsi od oblasti s menijem 1 (slika A.1).

SLIKA A.1: [ 3
Kako da odredite OA UTOCAD

mesta za oblasti s
menijima na tabli.

o

I\ AUTODESK ,

\

Gornji levi ugao prve oblasti menija

Donji levi ugao prve oblasti menija

Prva oblast menija

Donji desni ugao prve oblasti menija \

\ Gorniji levi ugao druge oblasti menija

Druga oblast menija

/ Donji levi ugao druge oblasti menija

Gornji desni ugao prostora -~
za digitalizaciju i gornji levi
ugao trece oblasti menija

Prostor za digitalizaciju
Donii levi ugao prostora za
digitalizaciju i doniji desni
ugao druge oblasti menija

Tre¢a oblast
menija

\ Gorniji levi ugao Cetvrte
oblasti menija

Doniji levi ugao Cetvrte oblasti menija

s/

Donji levi ugao trece oblasti menija ~ Donji desni ugao
trece oblasti menija

Cetvrta oblast menija

Doniji desni ugao Cetvrte oblasti menija \
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9]

10.

11.

12.

. Oznacite mesto na slici A.1 definisano kao gornji levi ugao oblasti sa menijem 1.

Ploc¢icom ili olovkom izaberite tu tacku. Pojavice se zahtev za unos:

Digitize lower left corner of menu area 1:

. Sad locirajte mesto oznaceno na slici kao donji levi ugao oblasti s menijima 1.
. Nastavite proces sve dok ne izaberete tri ugla za sve Cetiri oblasti s menijima.
. Posto definiSete oblast s menijima, dobicete zahtev za unos:

Do you want to respecify the Fixed Screen Pointing Area?

Otkucajte YO i izaberite mesto oznaceno na slici A.1.

. Na kraju cete dobiti zahtev:

Digitize upper right corner of screen pointing area:

Odaberite mesto oznaceno na slici A.1.

Tri zahteva za unos odnose se na prostor za digitalizaciju (engl. floating screen
pointing area). Ta opcija je neophodna da bi se, kada se tabla podesi za precrta-
vanje, priviemeno onemogucio pristup oblastima izvan prostora za crtanje. Pro-
stor za digitalizaciju omogucava pristup padaju¢im menijima i statusnoj traci i
tokom precrtavanja (poglavlje 11).

. Ako ne nameravate da precrtavate pomocu table, unesite N na sva tri zahteva za

unos. U suprotnom, uradite sledece.

. Na zahtev za unos:

Do you want to specify the Floating Screen Pointing Area? <N>:
upiSite YU
Na zahtev za unos:

Do you want the Floating Screen Pointing Area to be the same size
as the Fixed Screen Pointing Area? <Y>:

upisite YO ako hocete da obe oblasti koje ste definisali u koracima 6 i 7 budu jed-
nake veli¢ine. Upisite NO ukoliko deo table rezervisan za menije treba da bude
drugacije velic¢ine.

Poslednji zahtev za unos pita da li ¢ete preko tastera F12 ukljucivati i iskljucivati
prostor za digitalizaciju. (Sli¢no dejstvu funkcijskog tastera F10 u starijim verzi-
jama AutoCAD-a.) UpiSite YO ili N[J, u zavisnosti od toga da li ste se opredelili za
taster F12 ili neki drugi.

AutoCAD pamti definisanu konfiguraciju sve dok je ne promenite. Iz datoteke
izadite sa File > Exit.

Ukljucivanje nacina biranja Noun/Verb
Ukoliko iz bilo kog razloga modul Noun/Verb nije dostupan, pratite sledece korake
da biste ga aktivirali.

1.

2.
3.

Odaberite Tools > Options. Kada se pojavi okvir za dijalog Options, izaberite
karticu Selection.

U grupi dugmadi Selection Modes potvrdite opciju Noun/Verb Selection.
Pritisnite OK.



AKTIVIRANJE FUNKCIJE GRIPS

Sada bi trebalo da se vidi mali kvadrat u preseku koncanice. Taj kvadrat je okvir za
izbor (engl. pickbox) postavljen preko kursora. Obavestava vas da moZete birati objekte
¢ak i ako na zahtevu za unos na dnu ekrana nema aktivnih komandi. Kao $to ste videli
ranije, kvadrat nestaje istog trenutka kada pocnete da radite s komandom koja zahteva
izbor tacaka.

Modul Noun/Verb moZete aktivirati i upisivanjem '"Pickfirst] s komandne linije. Na
zahtev za unos New value for PICKFIRST <@>:upiSite 10 (ako upiSete 0, funkcija
Pickfirst se iskljucuje). Sistemska promenljiva Pickfirst cuva se u AutoCAD-ovoj konfi-
guracionoj datoteci. O sistemskim promenljivama saznacete vise u dodatku C.

Aktiviranje funkcije Grips

Ako funkcija Grips iz nekog razloga nije aktivna, pratite sledece korake da biste je
aktivirali:
1. Odaberite Tools > Options, a zatim u okviru za dijalog Options izaberite karticu
Selection.
2. U grupi Grips potvrdite polje Enable Grips.
3. Pritisnite OKi spremni ste za dalji rad.

Kartica Selection okvira za dijalog Options omogucava da odredite da li se ¢vorovi
pojavljuju na objektima koji ¢ine blok (vise o blokovima u poglavlju 4), i da zadate boju i
veli¢inu ¢vorova. U dodatku D opisano je kako se te opcije postavljaju pomocu sistem-
skih promenljivih.

Funkciju Grips moZete aktivirati i ako upiSete GripsU na komandnu liniju. Na zahtev
zaunos New value for GRIPS <@>: upiSite 1 za ukljucivanje ¢vorova ili 0 za iskljuci-
vanje ¢vorova. Sistemska promenljiva Grips ¢uva se u AutoCAD-ovoj konfiguracijskoj
datoteci.

Podesavanje funkcije Tracking Vector

Ako AutoCAD ne bude prikazivao funkciju Tracking Vector kao §to je objasnjeno u rani-
jim poglavljima knjige ili ako se ona ne ponasa kako je opisano, verovatno je ova opcija
isklju¢ena ili promenjena. Da bi se funkcija Tracking Vector ponasala kao $to je opisano
u knjizi, preduzmite sledece korake.
1. Izaberite Tools > Options da biste otvorili okvir za dijalog Options.
2. Izaberite karticu Drafting.
3. Potvrdite sve tri opcije u grupi AutoTrack Settings.
4. Proverite da li su u grupi AutoSnap Settings potvrdene opcije Marker, Magnet
i Display AutoSnap.
5. Proverite da li je u grupi Alignment Point Acquisition izabrano radio-dugme
Automatic.
6. Pritisnite OK da biste izasli iz ovog okvira za dijalog.
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Podesavanje AutoCAD-ovog sistema
za 3D grafiku

Performanse AutoCAD-ovog sistema za 3D grafiku moZete da podesite u okviru za dija-
log 3D Graphics System Configuration. Da biste otvorili ovaj okvir za dijalog, izaberite
karticu System okvira za dijalog Options i pritisnite dugme Properties iz grupe Current

3D Graphics Display.
v Adaptive degradation ———————————————— (T HendErD g
Ta maintain speed, degrade to the I™ | Enable liahts
following rendering modes: 2] Bl
™ Flat shaded ;‘ b
W Wireframe bl B
= B e Tran.sparenc_\tl
€ High Buality/Slovwer
Mairtsin speed: |3 _Ij FPS = Medium Gulity
& Lo Quality/Faster
v Dynamic tessellation ~ Geametry
Surface tessellation: I™ lsolines always on top
J— ¥ Discard back faces
o N
Lowe detail High detail S ——
Less memary More memory CEZERIED
Curve teszellation: & Software
J_ € Hardware
0’ 0 Select Driver IwupenglE.hd\ | -
Law detail High detail
s ey T roe I | sz mesmetry aceslertion [single presision]
Mumber of tessellations to cache: |4 _Ij I™ | Engtile anti-sliasing lines
Apply & Closel Cancel | Help |

Ovaj okvir za dijalog omogucava da kontroliSete na koji ¢e nacin AutoCAD prikazivati
3D modele dok koristite alatku 3D Orbit ili kada radite u rezimu Shade. Sledi spisak
opcija okvira za dijalog GSHEIDI10 3D Graphics System Configuration.

GRUPA ADAPTIVE DEGRADATION

Alatka 3D Orbit omogucava da prikaz sagledavate u realnom vremenu, §to predstavlja
veliki zahtev za graficki sistem va$eg racunara. Da bi 3D prikaz aZzuriran u realnom vre-
menu bio ravnomeran, AutoCAD ce pojednostaviti prikaz tokom njegove transforma-
cije. Opcije iz grupe Adaptive degradation omogucavaju da zadate nivo
pojednostavljivanja prikaza dok koristite alatku 3D Orbit.

Flat shaded Pomocu ove opcije zadajete AutoCAD-u da 3D prikaz objekta osenci
po algoritmu flat.

Wireframe Pomocu ove opcije zadajete AutoCAD-u da trodimenzionalne objekte
prikaze kao zicane modele.

Bounding box Pomocu ove opcije zadajete AutoCAD-u da pojednostavi 3D prikaz
objekta, tako da prikazuje konturne linije koje predstavljaju objekte.

Maintain speed FPS Omogucava da za prikazivanje 3D objekata u realnom vremenu
podesite broj kadrova u sekundi. Visa vrednost zahteva bolje performanse grafickog
sistema vaSeg racunara.
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GRUPA DYNAMIC TESSELLATION
Opcije ove grupe odreduju glatkost 3D objekata prilikom sencenja. Da bi se simulirala
glatkoca, sistem AutoCAD Heidi 3D Graphics zaobljene povrSine rastavlja na trouglove.

Surface tessellation Pomocu ove opcije kontroliSete kolicinu detalja prikazanih na
povrsini. Vise detalja zahteva i deljenje na viSe trougaonih povrsina, §to opet zahteva
vise sistemske memorije.

Curve tessellation Pomocu ove opcije kontroliete koli¢inu detalja prikazanih na
zaobljenim povr§inama. Vise detalja zahteva i deljenje na viSe trougaonih povrsina,
§to opet zahteva viSe sistemske memorije.

Number of tessellations to cache Ovom opcijom kontroliSete broj trouglova koji se
smestaju u kes. Kes$ je deo memorije rezervisan za cuvanje Cesto koris¢enih poda-
taka. AutoCAD ce u ke$ uvek smestiti jedan trougao (engl. tessellation). Ako u ke§
memoriju smestite dva trougla, poboljSacete izgled i performanse 3D objekata kada
koristite viSe prozora za prikaz.

GRUPA RENDER OPTIONS

Ako planirate da koristite AutoCAD-ovu alatku za vizuelizaciju, sledece opcije mogu biti
korisne. Kad primenite svetla i materijale na AutoCAD-ov 3D model, pomocu ovih opcija
mozete podesiti izgled vizuelizovane slike modela. U slucaju da je va$ racunar male
snage, trebalo bi da iskljucite ove opcije posto one koriste dodatnu radnu memoriju.

Enable backgrounds Ako ste 3D modelu dodali pozadinu, ova opcija omogucava da
pozadina bude vidljiva dok menjate model.

Enable lights Ova opcija omogucava da osenceni 3D model bude osvetljen svetlima
koja ste definisali upotrebom komande Light ili alatke Light s palete Render. Ako niste
definisali svetla, model ¢e biti prikazan kao da opcija Enable Lights nije aktivirana.

Enable materials Ova opcija omogucava da izgled osencenog 3D modela bude pri-
kazan zajedno s materijalima koje ste dodelili upotrebom komande Rmat ili alatke
Materials s palete Render. Ako niste definisali materijale, model ¢e biti prikazan
uobicajeno, kao da opcija Enable Materials nije aktivirana.

Enable textures Ova opcija omogucava da se izgled osencenog 3D modela prikaze
zajedno s teksturama koje ste modelu dodelili upotrebom komandi Rmat i Setuv ili
alatke Materials s palete Render. Opcija Enable Materials mora biti aktivna da bi se
ova opcija mogla koristiti.

Transparency Pomocu ove opcije moZete kontrolisati kvalitet prikazivanja provid-
nih povrsina osencenog 3D modela. Birate visok (engl. high), srednji (engl. medium)
ili nizak (engl. low) kvalitet prikazivanja providnih povr§ina. Nizak nivo prikazace
providne objekte sa efektom ,screen door*, dok ¢e srednji i visok nivo kvaliteta pri-
kazati providne objekte sa glatkijim povrSinama. Nizak nivo kvaliteta prikazivanja
omogucava brZe promene prikaza.

975



976 DODATAK A INSTALIRANJE | PODESAVANJE AUTOCAD-A

GRUPA GEOMETRY
Pomocu ovih opcija moZete zadati da li ¢e biti prikazana pozadina povrsi i izvodnice
(Isolines) na 3D modelima.

Isolines always on top Ako koristite opciju Flat Shaded/Edges On ili Gouraud Sha-
ded/Edges On komande Shademode (View > Shade > Flat Shaded/Edges On ili View
> Shade > Gouraud Shaded/EdgesOn) videcete da su izvodnice i trougaone povr-
Sine prikazane. Kada je opcija Isolines always on top uklju¢ena, izvodnice i trou-
gaone povrsine se pojavljuju i s prednje i sa zadnje strane povrsi.

Discard back faces U vecini sistema, pri vizuelizaciji se vidi samo jedna strana
povrsine. Pozadina povrsi je nevidljiva. Ovo nije vazno za povrsi kao $to su kvadar ili
lopta gde uvek vidite samo jednu stranu; medutim u nekim situacijama moZete da
vidite obe strane povrsi, kao $to je povr$ koju koristimo kao zid.

Ako je crtez sacinjen uglavnom od zatvorenih objekata, kao $to su kvadar ili lopta,
gde inace vidite samo jednu povrs, potvrdite polje Discard back faces da biste
poboljsali performanse sistema. U slucaju da se dosta povrSina mogu videti sa obe
strane, iskljucite ovu opciju.

GRUPA ACCELERATION
Omogucavaju da izaberete da li ¢ete koristiti softversko ili hardversko ubrzanje pri
crtanju 3D modela.

Software Pomocu ove opcije zadajete AutoCAD-u da za crtanje 3D objekata koristi
softversko ubrzanje.

Hardware Pomocu ove opcije zadajete AutoCAD-u da za crtanje 3D objekata koristi
hardversko ubrzanje kada je dostupno. Kada je ova opcija izabrana, moZete da iza-
berete upravljacki program za hardver iz padajuce liste Select Driver.

Use geometry acceleration (single precision) Cini da AutoCAD za geometriju obje-
kata koristi hardversko ubrzanje. Ova opcija je dostupna samo kada je opcija Hard-
ware izabrana, a va$a graficka kartica podrzava geometrijsko ubrzanje.

Enable anti-aliasing lines Cini da AutoCAD izgladi linije i ukloni nazubljenost linija
ilukova. Ova opcija je dostupna samo kada je opcija Hardware izabrana, a vasa gra-
ficka kartica podrzava uklanjanje nazubljenosti.



